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Introduction
This document describes how VPN Tracker can be used to establish a connection between a Mac 
running Mac OS X and a DrayTek Vigor/VigorPro firewall/router device. 

VPN Gateway Configuration
The first part of this guide will show you how to configure a VPN tunnel on your DrayTek device.

VPN Tracker Configuration
In the second part, this guide will show you how to configure VPN Tracker to easily connect to your newly created VPN tunnel.

Troubleshooting and Advanced Topics
Troubleshooting tips can be found in the last part of this guide. There you can also find a chapter on supporting VPN connections for 
multiple users.

Note This documentation is only a supplement to, not a replacement for, the instructions included with your DrayTek device. 
Please be sure to read those instructions and understand them before starting. The different DrayTek model / firmware 
revisions have different VPN capabilities. For definite information, please refer to your device’s data sheet.

Tip If you are setting up VPN on your device for the first time, we strongly recommend you start out with the tutorial-style 
setup in the first and second part of this document. 
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Important Prerequisites

Your VPN Gateway
‣ This guide applies to DrayTek Vigor/VigorPro devices that have support for IPsec VPN Remote Dial-In User / Teleworker Profiles, 

these include

• Vigor2110 Series

• Vigor2200 Series1

• Vigor27002/2710 Series

• Vigor2800/2820 Series

• Vigor2910/2930/2950 Series

• Vigor3100 Series

• VigorPro 5300/5500/5510 Series

‣ Make sure you have the newest available firmware installed on your device

Your Mac
‣ VPN Tracker runs on Mac OS X 10.4 or 10.5

‣ The configuration described in this guide requires at least VPN Tracker 5.4.2. Make sure you have all available updates installed. The 
latest VPN Tracker release can always be obtained from http://www.vpntracker.com
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2 Vigor2700e/2700Ge have no IPsec VPN capabilities and are not supported
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Scenario
In our example, we need to connect an employee's Mac to an office network. The following diagram illustrates this scenario:

VPN Connection

Mac running 
VPN Tracker

DrayTek Vigor
VPN Gateway

vpn.example.com
Office Network

192.168.13.0 / 255.255.255.0

This guide assumes that the Mac running VPN Tracker already has internet connectivity. The office's DrayTek device (the “VPN 
gateway”) is also already connected to the Internet and can be accessed through a static IP address or DNS host name. In our 
example setup, we will be using a host name: vpn.example.com.

The VPN gateway has a second network interface which is connected to the internal office network (LAN). In our example, the office 
network has the IP range 192.168.13.0/24 (which is the same as 192.168.13.0/255.255.255.0). This is the network that will be accessed 
from the employee’s Mac through the VPN. It is called the “Remote Network” in VPN Tracker.
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Terminology
A VPN connection is often called a “tunnel” (or “VPN tunnel”). Every VPN tunnel is established between two “endpoints”. In our 
example one endpoint is VPN Tracker and the other endpoint is the VPN gateway. Each endpoint is called the other endpoint’s “peer”.

Please note that for each endpoint, the settings on the other endpoint are considered to be “remote”, while its own settings are 
considered to be “local”. That means a “local” setting from VPN Tracker’s perspective, is a “remote” setting from the VPN gateway’s 
perspective, and vice versa.

The sample configuration described in this guide is called a “Host to Network” configuration: A single computer, called a “Host” 
establishes a VPN tunnel to an entire “Network” behind the VPN gateway.
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My DrayTek Configuration

➊ Peer ID:                                                                                       

➋ Pre-Shared Key:                                                                     

➌: LAN IP Address:              .              .              .           

➍: LAN Subnet Address:              .              .              .           

➎ LAN Network Address:               .              .              .            

➏ WAN IP Address:               .              .              .             (or DNS host name                                                      )

TIP To set up your VPN connection, you'll need to keep track of certain pieces of information. Those details are indicated by red 
numbers. Throughout this guide we will be referencing those numbers.
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Task 1 – Configure your DrayTek
This section describes the configuration of your DrayTek Vigor VPN router. If you do not yet have VPN 
configured and in use on your device, please proceed exactly as described in this section. We will be 
creating a connection using a Remote Dial-in User.

Step 1 – Enable the IPsec VPN Service

‣ Access your device’s web configuration 
interface and enter your user name and 
password, if required

‣ Select “VPN and Remote Access”

‣ Click “Remote Access Control”

‣ Check the box “Enable IPsec VPN Service”

‣ Click “Ok”
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Step 2 - Add a New Remote Dial-In User

‣ Click “Remote Dial-In User”

‣ Remote Access User Accounts: Click on an 
unused number (e.g. “1.”)
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Step 3 - Configure the New Remote Dial-In User

➊

‣ User Accounts and Authentication

‣  Check the box “Enable this account”

‣ Make sure the Idle Timeout is set to “0” 
seconds

‣ Allowed Dial-In Type

‣ Check the box “IPsec Tunnel”

‣ If you don’t plan to be using the other 
options (e.g. PPTP), uncheck them

‣ Check the box “Specify Remote Node”

‣ Peer ID: Enter an identifier for this connection 

(e.g. “vpntracker”) ➊
‣ IKE Authentication Method

‣ Check the box “Pre-Shared Key”

‣ IPsec Security Method

‣ Uncheck the box “Medium (AH)”

‣ High (ESP): We recommend checking 3DES 
and AES, but not DES. Make sure at least one 
method is always checked.

Note The peer ID is case-sensitive. Make sure to write down the peer ID, including capitalization.
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Step 4 - Set the Pre-Shared Key

➋
➋

‣ Click the “IKE Pre-Shared Key” button

‣ Pre-Shared Key: Enter a password for the connection ➋

‣ Re-type Pre-Shared Key: Enter the same password again ➋

‣ Click “Confirm” in the pop up window

‣ Click “Ok” to save the new Remote Dial-in User.
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Step 5 - Retrieve the LAN Settings

2 ➏

➌
➍

‣ Click on the large “Vigor ... Series” logo at the very top left 
corner of the configuration interface to get to the “System 
Status” display

‣ LAN IP Network Configuration

‣ Write down the “1st IP Address” ➌

‣ Write down the “1st Subnet Mask” ➍

‣ Calculate your LAN Network Address by applying the LAN 
Subnet Mask ➍ to the LAN IP Address ➌:

‣ Applying the subnet mask means setting those elements 
of the IP address to 0 where the subnet mask is 0, and 
preserving all elements where the subnet mask is 255. In 
our example:

Write down the LAN Network Address you have 
calculated as ➎

‣ WAN IP Network Configuration

‣ Write down the IP address ➏

192 168 13 1

255 255 0255. . .

. . .

LAN Subnet Mask

LAN IP Address

applied to

LAN Network Address 192 168 13 0. . .
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Task 2 – Configure VPN Tracker
This section describes how to configure VPN Tracker to connect to your DrayTek. You will need the 
configuration information you collected during Task 1.

‣ Start VPN Tracker

‣ Click the “+” button in the main window

You will be asked to select a device profile for the 
new connection:

‣ Select “DrayTek” from the list

‣ Select your device from the list of DrayTek 
devices. 

‣ If there is more than one choice, choose 
“Remote Dial-In User Profile”.

Do not choose the legacy “LAN-to-LAN” 
profile if your device supports IPsec VPN for 
Remote Dial-In User profiles (the LAN-to-LAN 
profile configuration is not described in this 
guide).

‣ Connection Name: Choose a name for your 
connection (e.g. “Office”)

‣ Click “OK”
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Step 2 – Configure the VPN Connection

➏

➎ ➍

➊

‣ VPN Gateway: Enter your DrayTek’s public IP address 
➏. If you are using Dynamic DNS, or if the device has 
a DNS host name, use it instead (in our example, we 
are using the host name “vpn.example.com”)

‣ Local Address: Can be left empty for now. You may 
have to eventually enter a specific IP address here, 
please see the chapter on “Supporting Multiple 
Users” for details

‣ Remote Networks: Enter the calculated network 
address ➎ and the subnet mask ➍ of the network 
that is being accessed through the VPN tunnel 
Separate the subnet mask with a forward slash (“/”)

‣ Local Identifier: Enter the Peer ID from your DrayTek 
(e.g. “vpntracker”) ➊

Note If you are missing any of the required information, refer back to the previous chapter.
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Task 3 – Test the VPN Connection
This section explains how to start and test your VPN connection.

It‘s time to go out!
You will not be able to test and use your VPN connection from within the internal network that you want to connect to. In order to 
test your connection, you will need to connect from a different location. For example, if you are setting up a VPN connection to your 
office, test it from home. If you are setting up a VPN connection to your home network, test it from an Internet cafe, or go visit a 
friend.

Start your connection

 

‣ Connect to the Internet

‣ Make sure that your Internet connection is working – open your Internet browser and try to connect 
to http://www.equinux.com

‣ Start VPN Tracker if it’s not already running

‣ Slide the On/Off slider for the connection you have just configured to On
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When you are prompted for your pre-shared key:

➋

‣ Pre-shared key: Enter the pre-shared key that you configured on the VPN 
gateway ➋

‣ Optionally, check the box “Store in Keychain” to save the password in your 
keychain so you are not asked for it again when connecting the next time

‣ Click “OK”

‣ If the slider goes back to Off after starting the connection, or after entering your pre-shared key, 
please read the Troubleshooting section of this document

‣ If the slider goes to On and turns green after a while, you have successfully established a connection

Congratulations!
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Supporting Multiple Users
Once your VPN expands to multiple users (or even just yourself connecting from multiple computers 
simultaneously), there are certain issues you will have to consider. Primarily, you must ensure that IP 
addresses do not conflict. In addition to purely technical considerations, VPN Tracker makes it easy to 
distribute pre-configured connections to your users, and prevent the modification of VPN connections 
and access to confidential data.

Preventing IP Address Conflicts
If multiple users connect to your DrayTek at the same time, you must ensure that each of them uses a different Local Address in 
VPN Tracker by setting an individual Local Address for each of them.

Choosing the Local Address
The Local Address must not be part of the remote network (i.e. the DrayTek’s LAN) and the same Local Address may not be used by 
two VPN clients at the same time.

Example: The DrayTek’s LAN in this example is the network 192.168.13.0/24 (= 
192.168.13.0/255.255.255.0). Choose an arbitrary private network that is not 
part of this network, such as 10.22.13.0/24, and manually assign each user of 
the VPN a different IP address from that network to be used as the Local 
Address in VPN Tracker.

Advanced Users A more detailed description of the Local Address setting is available in the last chapter of this document.

User IP Address

alice 10.22.13.1

bob 10.22.13.2

charlie 10.22.13.3

... 10.22.13._
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Configuring the DrayTek for Multiple Users
Adding new VPN users to your DrayTek is easy: For each additional VPN user, simply add a new “Remote Dial-In User” profile, with a 
different Peer ID, and – if desired – a different pre-shared key. With some DrayTek models and firmware revisions it may be possible 
for multiple users to share a single Remote Dial-In User Profile. However, it will still be necessary for each of the users of such a shared 
profile to have a different “Local Address” in VPN Tracker.

Configuring VPN Tracker for Multiple Users
When adding additional VPN users users to your DrayTek for the first time, edit the VPN 
Tracker connection of the original user to use the fixed “Local Address” you have chosen for 
the user. 

Once the initial user’s connection has been modified, you can begin to set up the VPN 
Tracker connections for other users. The setup is mostly identical to the first user’s connection, with the following differences:

‣ The “Local Address” must be set to the IP address chosen for this particular user

‣ The “Local Identifier” must be set to the Peer ID of the user’s Remote Dial-In Profile on the DrayTek

‣ If you are using a different pre-shared key for this user’s Remote Dial-In Profile, use this pre-shared key

Note The total number of VPN users, as well as the number of VPN users that can be connected concurrently, is limited by your 
DrayTek’s firmware and hardware. Please refer to your device’s data sheet for details.

Note Some DrayTek models (in particular those that do not support NAT-Traversal) only accept a single VPN connection from a 
particular public IP address. With these devices, it will not be possible to connect two computers from behind the same 
NAT router to the VPN.
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Deploying VPN Connections to Your Users
VPN Tracker Professional Edition offers a number of ways to easily distribute pre-configured connections to users. It is even possible 
to create a custom VPN Tracker application that contains a pre-configured connection and a license voucher for your users.

Further information on deploying connections to users is available in the VPN 
Tracker manual.

Tip To deploy VPN Tracker to many users, 
you can create a custom VPN Tracker 
application with a pre-configured 
connection and a license voucher, 
choose File > Prepare Deployment.

‣ Encryption Password: Exported connections are always encrypted. The 
password must be entered by the recipient of the exported connection in 
order to import the connection

‣ Lock Connections: Locked connections cannot be edited by users. This 
prevents accidental changes to a connection. In addition, the pre-shared key 
of a locked connection will not be displayed to users

‣ Set Unlock Password: In case you need to make a quick modification to a 
locked connection on a user’s Mac, you can add an unlock password that will 
allow you to modify the connection. Click the padlock icon in the upper right 
corner of the VPN Tracker window to unlock a connection

‣ Hide Basic and Advanced settings from users when locked: This setting 
can be used to hide all connection information from users

‣ Include Actions: If you wish, you can define actions to be performed upon 
connection start / stop, such as connecting to a database, or disconnecting 
from all file servers in the VPN when the connection is stopped. These 
actions can optionally be included in an exported connection

‣ Email: If you specify an email address here, Technical Support Reports 
created by your users will be sent to this email address
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Troubleshooting
In most cases, your connection should work fine if you follow the instructions above. If you cannot 
connect, please read on.

VPN Connection Fails to Establish

On/Off Slider goes back to “Off” right away
If the slider goes back to “Off” right away, please make sure you have entered all the required information. VPN Tracker will highlight 
fields that are missing or obviously incorrect information.

On/Off Slider goes back to “Off” after a while
If the connection ON/OFF slider goes back to “OFF” a while after 
attempting to start the connection, please go to the “Log” tab to get 
more information about the error (or click the warning triangle to be 
automatically taken to the “Log” tab).

Depending on the actual problem, VPN Tracker will display detailed 
suggestions for a solution.
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Cannot Access Resources on the Remote Network  
If the connection slider goes to ON and turns green, but you cannot access resources (servers, email, etc.) in the remote network, 
please check the following points:

Connect by IP address instead of host name
If you are not connecting to the resource by IP address (e.g. 192.168.13.42), but are using a host name (e.g. server.example.com), please 
try using the resource’s IP address instead. If the connection works when using the IP address, but not when using a host name, 
please make sure that the DNS server configured on your Mac’s is able to resolve this host name to an IP address, or configure a 
“Remote DNS” server in VPN Tracker.

Run the VPN Environment Manager
In many local networks your Mac will be behind a router that performs Network Address Translation (NAT). For a VPN connection to 
be established through such a router, VPN Tracker can use one of three different methods, but not all of them may be supported by 
your local router or your VPN gateway. In that case, your VPN connection may seem connected, but no connections to servers or 
other resources in the VPN are possible. VPN Tracker includes a tool to detect the right method for the local network:

‣ Stop all running VPN connections

‣ Select “Help > VPN Environment Manager”

‣ Click on “Continue”

‣ Wait until VPN Tracker has performed the tests

‣ Try to start the connection again

Tip You will only have to run the VPN Environment Manager once for each location that you are using VPN Tracker at.
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Check if the IP address of the resource is part of the remote network
Please make sure that the IP address of the resource that you are connecting to is actually contained in the remote network(s). Also 
double-check the network mask that you have configured for the remote network(s) in VPN Tracker. 

Make sure the VPN gateway is the default gateway in the remote network
If it is not, you will have to ensure that responses to all IP addresses in the address pool (see Step 1) are routed to the VPN gateway, 
either by adding a general route on the network’s default gateway, or by adding individual routes on each host that VPN clients need 
to communicate with.

Further Questions?
You can find the latest news and compatibility information on our support and FAQ website:

http://www.equinux.com/support

If you need to contact equinux Technical Support
If you can’t resolve your issue with the information available on our website or in this guide and would like to contact Technical 
Support through our website, please be sure to include at least the following information:

‣ The manufacturer and model and firmware revision of the VPN gateway

‣ A Technical Support Report from VPN Tracker (Help > Generate Technical Support Report)

‣ Screenshots of what you have configured on your VPN gateway, in particular all VPN settings

‣ A detailed description of the problem and the troubleshooting steps you have taken

Tip The network mask (e.g. 255.255.255.0) determines the size of a network. Some examples: The network 
192.168.1.0/255.255.255.0 contains all IP addresses starting with 192.168.1.x. The network 192.168.1.0/255.255.255.255 contains 
only a single IP address, 192.168.1.0.
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Appendix
The Role of the Local Address in VPN Tracker
The local address is the IP address that your Mac uses in the remote network when connected through VPN.  If the Local Address 
field is left empty, the Mac’s actual local IP address (as shown in System Preferences > Network) is used

When to Set the Local Address in VPN Tracker
Always use a fixed Local Address if

‣ multiple clients (users/computers) use the VPN

‣ the DrayTek device is not the default gateway (router) in the remote network

Choosing the Local Address
When connecting to a DrayTek device, the Local Address must not be part of the remote network (i.e. the DrayTek’s LAN) and the 
same Local Address may not be used by two VPN clients at the same time. If there is only a single user of the VPN, this will often 
automatically be the case if the Local Address field is simply left empty, and VPN Tracker therefore uses the Macs local IP address. 
However, in all other circumstances, you should configure a specific address.

Example:The DrayTek’s LAN in this example is the network  192.168.13.0/24 
(= 192.168.13.0/255.255.255.0). Choose an arbitrary private network that is not 
part of this network, such as 10.22.13.0/24, and manually assign each user of 
the VPN a different IP address from that network to be used as the Local 
Address in VPN Tracker.

Advanced Users The Local Address is used as the endpoint of the IPsec Security Association (SA) on the VPN Tracker side that is 
established in phase 2 of the connection process.

User IP Address

alice 10.22.13.1

bob 10.22.13.2

charlie 10.22.13.3

... 10.22.13._
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Local Addresses for the More Curious
Why can’t I use a Local Address from my DrayTek’s LAN?

It may sound a bit unusual to use IP addresses that are not part of the DrayTek’s LAN. The reason for this is that the DrayTek cannot 
act as a so-called “ARP Proxy” for its VPN clients. Computers on the DrayTek’s LAN therefore must be “tricked” into sending replies for 
VPN clients to the DrayTek by using IPs from outside the local network (for which replies are sent to the default gateway).

My users connect from different places, from different IPs. Why do I still need to give them different Local Addresses?

In most cases, the connecting Macs will be behind routers (DSL routers, wireless access points, ...) that perform Network Address 
Translation (NAT), meaning they map several private IP addresses onto a single public IP address. The Macs themselves will have a 
private IP address for their Ethernet or AirPort interface, and this is the IP address that is used by VPN Tracker if the Local Address field 
is empty.

Because of this, the likelihood of two Macs using the same local address is very high:  Many NAT routers are by default configured to 
use the same private networks (192.168.1.0/24 and 10.0.0.0/24 are popular), and therefore there is a good chance that two clients 
connecting from entirely different places will have the same local IP address assigned by their respective local router. Therefore it is 
essential to configure a different Local Address in VPN Tracker for each VPN user if multiple users connect concurrently.

Why do I need a fixed Local Address when my DrayTek is not the default gateway/router in its LAN?

If the DrayTek is not the default gateway, this means that computers the VPN clients communicate with do not connect to the 
Internet through the DrayTek. 

In such an environment, you will have to ensure that those computers (and all other resources accessed through the VPN, such as 
printers and NAS drives) know where to send replies for VPN clients . This is much easier, if you know what IP addresses your VPN 
clients will be using, and therefore you should enter an individual fixed IP address in the Local Address field on each VPN client.  

Once you have decided on a range of IP address to be used for VPN clients, you can either 

‣ set a route to the DrayTek for the VPN clients’ IP addresses on each host that needs to communicate with VPN clients, or 

‣ have the default gateway redirect all traffic for the VPN clients’ IP addresses to the DrayTek
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